
 
 TPC-2515

https://www.apexwaves.com/modular-systems/national-instruments/touch-panel-computers/TPC-2515?aw_referrer=pdf
https://www.apexwaves.com/modular-systems/national-instruments/touch-panel-computers/TPC-2515?aw_referrer=pdf
https://www.apexwaves.com/modular-systems/national-instruments/touch-panel-computers/TPC-2515?aw_referrer=pdf


PPC-2115/TPC-2515

User Manual

PPC-2115/TPC-2515 User Manual

August 2009

372053C-01



Support

Worldwide Technical Support and Product Information

ni.com

National Instruments Corporate Headquarters

11500 North Mopac Expressway Austin, Texas 78759-3504 USA Tel: 512 683 0100

Worldwide Offices

Australia 1800 300 800, Austria 43 662 457990-0, Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599, 

Canada 800 433 3488, China 86 21 5050 9800, Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, 

Finland 358 (0) 9 725 72511, France 01 57 66 24 24, Germany 49 89 7413130, India 91 80 41190000, 

Israel 972 3 6393737, Italy 39 02 41309277, Japan 0120-527196, Korea 82 02 3451 3400, 

Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710, Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466, 

New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60, Poland 48 22 328 90 10, Portugal 351 210 311 210, 

Russia 7 495 783 6851, Singapore 1800 226 5886, Slovenia 386 3 425 42 00, South Africa 27 0 11 805 8197, 

Spain 34 91 640 0085, Sweden 46 (0) 8 587 895 00, Switzerland 41 56 2005151, Taiwan 886 02 2377 2222, 

Thailand 662 278 6777, Turkey 90 212 279 3031, United Kingdom 44 (0) 1635 523545

For further support information, refer to the Technical Support and Professional Services appendix. To comment 

on National Instruments documentation, refer to the National Instruments Web site at ni.com/info and enter 

the info code feedback.

© 2007–2009 National Instruments Corporation. All rights reserved.



 Important Information

Warranty
The PPC-2115/TPC-2515 is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as 
evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective 
during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in 
materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments 
will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects 
during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any 
equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by 
warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In 
the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document 
without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National 
Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL 
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING 
FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of 
the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against 
National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in 
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service 
failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the 
product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside 
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other 
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only 
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no agency, 
partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products/technology, refer to the appropriate location: Help»Patents in your software, 
the patents.txt file on your media, or the National Instruments Patent Notice at ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE 
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, 
TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR 
ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER 
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF 
HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY 
UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, 
THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, 
INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS 
CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION 
DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT 
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY 
RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER 
NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT 
LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

Electromagnetic Compatibility Information
This hardware has been tested and found to comply with the applicable regulatory requirements and limits for electromagnetic 

compatibility (EMC) as indicated in the hardware’s Declaration of Conformity (DoC)1. These requirements and limits are 
designed to provide reasonable protection against harmful interference when the hardware is operated in the intended 
electromagnetic environment. In special cases, for example when either highly sensitive or noisy hardware is being used in close 
proximity, additional mitigation measures may have to be employed to minimize the potential for electromagnetic interference.

While this hardware is compliant with the applicable regulatory EMC requirements, there is no guarantee that interference will 

not occur in a particular installation. To minimize the potential for the hardware to cause interference to radio and television 
reception or to experience unacceptable performance degradation, install and use this hardware in strict accordance with the 

instructions in the hardware documentation and the DoC1.

If this hardware does cause interference with licensed radio communications services or other nearby electronics, which can be 
determined by turning the hardware off and on, you are encouraged to try to correct the interference by one or more of the 
following measures:

• Reorient the antenna of the receiver (the device suffering interference).

• Relocate the transmitter (the device generating interference) with respect to the receiver.

• Plug the transmitter into a different outlet so that the transmitter and the receiver are on different branch circuits.

Some hardware may require the use of a metal, shielded enclosure (windowless version) to meet the EMC requirements for 
special EMC environments such as, for marine use or in heavy industrial areas. Refer to the hardware’s user documentation and 

the DoC1 for product installation requirements.

When the hardware is connected to a test object or to test leads, the system may become more sensitive to disturbances or may 
cause interference in the local electromagnetic environment.

Operation of this hardware in a residential area is likely to cause harmful interference. Users are required to correct the 
interference at their own expense or cease operation of the hardware.

Changes or modifications not expressly approved by National Instruments could void the user’s right to operate the hardware 
under the local regulatory rules.

1   The Declaration of Conformity (DoC) contains important EMC compliance information and instructions for the user or 
installer. To obtain the DoC for this product, visit ni.com/certification, search by model number or product line, 
and click the appropriate link in the Certification column.



Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 

avoid injury, data loss, or a system crash. When this symbol is marked on a 

product, refer to the Safety section of Appendix A, Specifications, for 

information about precautions to take.

When symbol is marked on a product, it denotes a warning advising you to 

take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be 

hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such 

as menu items and dialog box options. Bold text also denotes parameter 

names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 

to a key concept. Italic text also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames, and extensions.
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1
General Information

This chapter includes general information about the PPC-2115/TPC-2515 

Human Machine Interface (HMI).

Introduction

The PPC-2115/TPC-2515 touch panel computer, a state-of-the-art HMI 

based on an x86 platform, includes these key features:

• Fanless—Because the system uses a low-power processor, it does not 

need fans, which often are unreliable and cause dust to circulate inside 

the equipment.

• Bright display—The TFT LCD features a 15 in. display that meets 

industrial demands for clear interfaces.

• Powerful communication capability—The PPC-2115/TPC-2515 is a 

powerful I/O interface for easy communication with other devices. The 

I/O interface includes serial ports, an RS485 port, a parallel port, and 

Ethernet and USB 2.0 support.

• Windows Operating System—The PPC-2115 and TPC-2515 support 

the Windows XP and Windows XP Embedded platforms, respectively.

I/O Ports

The PPC-2115/TPC-2515 includes the following ports:

• One parallel port that supports EPP/ECP/SPP modes

• Three serial ports: RS232 (COM1 and COM3) and RS232/422/485 

(COM4)

• Two RJ-45 Ethernet ports: LAN 1 (10/100BaseT) and LAN2 

(10/100/1000BaseT)

• One PS/2 port: 6-pin mini-DIN port for keyboard and mouse

• Two USB ports compliant with USB 2.0

• One CompactFlash slot

• One PCMCIA slot

• Three audio ports: one microphone, one line in, and one line out



Chapter 1 General Information

PPC-2115/TPC-2515 User Manual 1-2 ni.com

Figure 1-1 shows the I/O port arrangement.

Figure 1-1.  I/O Port Arrangement

For more PPC-2115/TPC-2515 specifications, see Appendix A, 

Specifications.

1 Parallel Port

2 LAN1

3 LAN2

4 USB

5 PS/2

6 COM3 (RS232)

7 COM4 (RS232/422/485)

8 COM1 (RS232)

9 VGA

1 2 3 4 5 6 7 8 9
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2
System Setup

This chapter includes setup information for the PPC-2115/TPC-2515.

Important Safety Information

Before setting up the PPC-2115/TPC-2515, read these safety instructions 

carefully.

Disconnect this equipment from any AC outlet before cleaning. Use a damp 

cloth. Do not use liquid or spray detergents for cleaning.

For plug-in equipment, the power outlet socket must be located near the 

equipment and must be easily accessible.

Keep this equipment away from humidity.

Place this equipment on a reliable surface during installation. Dropping it 

or letting it fall may cause damage.

The openings on the enclosure are for air convection. Protect the equipment 

from overheating. Do not cover the openings. 

Make sure the power source voltage is correct before connecting the 

equipment to the power outlet.

Position the power cord so that people cannot step on it. Do not place 

anything over the power cord.

All cautions and warnings on the equipment should be noted.

If the equipment is not used for a long time, disconnect it from the power 

source to avoid damage by transient overvoltage.

Never pour any liquid into an opening. This may cause fire or electrical 

shock.

Never open the equipment. For safety reasons, only qualified service 

personnel should open the equipment.
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If one of the following situations arises, have service personnel check the 

equipment:

• The power cord or plug is damaged.

• Liquid has penetrated into the equipment.

• The equipment has been exposed to moisture.

• The equipment does not work well, or you cannot get it to work 

according to the user manual.

• The equipment has been dropped and damaged.

• The equipment has obvious signs of breakage.

Do not leave this equipment in an environment where the storage 

temperature may go below –20 °C (–4 °F) or above 60 °C (140 °F). Doing 

so could damage the equipment. The equipment should be in a controlled 

environment.

Caution There is a danger of explosion if the battery is incorrectly replaced. Replace the 

battery only with the same or equivalent type recommended by the manufacturer. Discard 

used batteries according to the manufacturer’s instructions.

The sound pressure level at the operator’s position according to 

IEC 704-1:1982 is no more than 70 dB (A).

Setup

Follow these steps to set up the PPC-2115/TPC-2515:

1. Unpack the PPC-2115/TPC-2515. Be sure your kit includes the 

following items:

• The PPC-2115/TPC-2515 HMI

• Eight panel mounting clamps

• Eight panel mounting screws

• One 3-pin power connector and wire

• One PS/2 splitter cable

• One HMI Resource CD

• One CompactFlash to IDE adapter card

If any items are missing or damaged, contact National Instruments.

Caution Be sure system power is off before plugging in or pulling out the 

CompactFlash card.
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2. Connect the power connector to 24 VDC power lines. Be sure 

to connect the positive, negative, and ground lines as shown in 

Figure 2-1. The power lines can be from either a power adapter or 

in-house power source.

Figure 2-1.  Power Connector

3. Connect the power connector to the power receptor on the 

PPC-2115/TPC-2515. The power receptor pin assignment is shown in 

Figure 2-2.

Figure 2-2.  Power Receptor and Pin Assignment

4. Press the power button to power on the system.

Touchscreen Calibration
The PPC-2115/TPC-2515 touchscreen should be correctly calibrated and 

ready to use when you power on the system. However, if the calibration is 

not correct or you want to choose custom calibration options, refer to 

Appendix E, Touchscreen Configuration.

+ – GND

GND – +
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Dual Display Setting

To use an auxiliary CRT monitor with the PPC-2115/TPC-2515, connect 

the monitor to the CRT port on the PPC-2115/TPC-2515. Follow these 

steps to configure the CRT monitor settings:

1. After powering on the system, click the Intel icon in the toolbar on the 

PPC-2115/TPC-2515 LCD monitor.

2. Select Graphics Options»Output Device.

3. The display options window appears, showing the currently active 

display device. Use this window to select and configure alternate 

display devices.

Panel Mounting

Follow these steps to mount the PPC-2115/TPC-2515 in a panel:

1. Be sure the adhesive waterproof gasket on the front bezel is in position.

2. Install the PPC-2115/TPC-2515 into the panel opening. (Refer to 

Appendix A, Specifications, for cutout dimensions.)

3. Attach the clamps included in the accessory pack to the holes in the 

bezel.

4. Insert the screws included in the accessory pack into the clamps. 

Tighten the screws to fasten the PPC-2115/TPC-2515 against the 

panel.

Note The mounting panel thickness should be less than 6 mm (0.236 in.).
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3
Jumpers and Connectors

This chapter describes the PPC-2115/TPC-2515 jumpers and connectors.

Jumper and Connector Functions

Table 3-1 lists the jumper and connector functions.

Table 3-1.  Mainboard Connectors and Jumpers

Label Function Description

CN1 VGA D-Sub 15-pin (female) on 

panel

CN2 DC in DC power in connector 

(5.08 mm, 3-pin housing)

CN3 PCMCIA One-slot PCMCIA 

connector

CN4 LCD power LCD inverter connector

CN5 PS2 Standard mini-DIN 6-pin 

supports keyboard and 

mouse

CN7 USB Two USB type-A female

CN9 IDE Internal IDE 44-pin 

(2 mm) connector

CN10 PRT D-Sub 25-pin (female)

CN11 CF CompactFlash socket

CN12 Speaker out Internal speaker connector

CN13 Mic in Audio mic in

CN14 Line out Audio line out

CN15 Line in Audio line in
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Jumper and Connector Locations

Figure 3-1 shows the jumper and connector locations.

CN16 * (JP1) LVDS LCD Internal 18-bit LVDS 

LCD connector

CN17 * (JP3) Touch Internal touchscreen 

connector

COM1 COM1 Serial port: COM1 RS232

COM3 COM3 Serial port: COM3 RS232

COM4 COM4 Serial port: COM4 

RS232/422/485

S1 COM4 MODE1 Setting COM4 

RS232/422/485 mode

S2 COM4 MODE2 Setting COM4 RS422 

master or slave mode

JP4 Clear CMOS Clear CMOS

SW1 Power switch System power switch

Table 3-1.  Mainboard Connectors and Jumpers (Continued)

Label Function Description
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Figure 3-1.  Mainboard Jumpers and Connectors
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A
Specifications

Physical
Weight .................................................... 5.5 kg (without HDD)

Cutout dimensions.................................. 373.5 × 297.5 mm (suggested)
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Dimensions

383 mm

[15.079 in]

373 mm

[14.685 in]

4.5 mm [0.177 in]

64 mm [2.52 in]

297 mm [11.693 in]

307 mm [12.087 in]
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System Kernel
CPU........................................................ Intel Celeron M (clock rate 

600 MHz/1 GHz)

BIOS....................................................... Award 4 Mbit flash memory

South bridge ........................................... Intel 855GME/852GM 

GMCH/ICH4 chipset

VGA ....................................................... Intel 855GME for 

PPC-2115/TPC-2515-A series; 

Intel 852GM for 

PPC-2115/TPC-2515-B series; 

supports 16 MB frame buffer with 

system memory; simultaneous 

support of CRT and LVDS flat 

panel display

Ethernet .................................................. Intel 82562EZ and 

Intel 82551QM Ethernet 

controller; IEEE 802.3u protocol 

compatible

Watchdog timer...................................... W83627 watchdog timer; 

1.6 s timeout period

IDE......................................................... 2 EIDE channels support one IDE 

compact flash socket onboard and 

one 44-pin (2 mm) connector

LCD
Display type ........................................... TFT color LCD

Size (diagonal) ....................................... 15 in.

Maximum resolution .............................. 1024 × 768 (XGA)

Maximum colors .................................... 256,000

Pixel pitch (W × H, mm)........................ 0.3075 × 0.3075

Viewing angle ........................................ 120

Luminance (cd/m2)................................. 350
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Contrast ratio ..........................................500

Operating temperature ............................0 to 50 °C (32 to 122 °F) 

(ambient)

Backlight.................................................2 CCFL

Backlight life time ..................................50,000 h

Note There may be several bright or dark pixels on the LCD. This phenomenon is normal 

in LCD manufacturing.

Touchscreen
Touchscreen type ....................................Resistive

Base glass construction...........................Tempered glass

Resolution ...............................................1024 × 1024

Light transmission ..................................75% typical

Controller................................................RS232 interface

Power rating............................................3.3 to 5 V

Durability................................................100 million touches

Power
Input voltage ...........................................18 to 32 VDC (the fuse becomes 

an open circuit if the input level 

exceeds 33 VDC)

Typical ....................................................24 VDC, 2.0 A

Fuse
Rating......................................................T3.15 A, 250 V

Size .........................................................5 × 20 mm

Note When replacing the fuse, use only a fuse of the same type and rating.

Note For your protection, the fuse is set to break if the input voltage exceeds 33 VDC.
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Environment
Operating temperature............................ 0 to 50 °C (32 to 122 °F)

Storage temperature ............................... –20 to 60 °C (–4 to 140 °F)

Humidity ................................................ 40 °C @ 10 to 95% relative 

humidity (noncondensing)

Vibration ................................................ 1 grms (5 to 500 Hz)

Maximum altitude .................................. 2,000 m

Pollution Degree .................................... 2

Indoor use only

Safety
This product meets the requirements of the following standards of safety 

for electrical equipment for measurement, control, and laboratory use:

• IEC 60950-1, EN 60950-1

• UL 60950-1, CSA 60950-1

Note For UL and other safety certifications, refer to the product label or the Online 

Product Certification section.

Electromagnetic Compatibility
This product meets the requirements of the following EMC standards for 

electrical equipment for measurement, control, and laboratory use:

• EN 61326 (IEC 61326): Class A emissions; Basic immunity

• EN 55011 (CISPR 11): Group 1, Class A emissions

• AS/NZS CISPR 11: Group 1, Class A emissions

• FCC 47 CFR Part 15B: Class A emissions

• ICES-001: Class A emissions

Note For the standards applied to assess the EMC of this product, refer to the Online 

Product Certification section.

Note For EMC compliance, operate this product according to the documentation.
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CE Compliance
This product meets the essential requirements of applicable European 

Directives as follows:

• 2006/95/EC; Low-Voltage Directive (safety)

• 2004/108/EC; Electromagnetic Compatibility Directive (EMC)

Online Product Certification
Refer to the product Declaration of Conformity (DoC) for additional 

regulatory compliance information. To obtain product certifications and the 

DoC for this product, visit ni.com/certification, search by model 

number or product line, and click the appropriate link in the Certification 

column.

Environmental Management
NI is committed to designing and manufacturing products in an 

environmentally responsible manner. NI recognizes that eliminating certain 

hazardous substances from our products is beneficial to the environment 

and to NI customers.

For additional environmental information, refer to the NI and the 

Environment Web page at ni.com/environment. This page contains the 

environmental regulations and directives with which NI complies, as well 

as other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)

EU Customers At the end of the life cycle, all products must be sent to a WEEE recycling 

center. For more information about WEEE recycling centers and National Instruments 

WEEE initiatives, visit ni.com/environment/weee.

RoHS

National Instruments  (RoHS)
National Instruments RoHS ni.com/environment/rohs_china

(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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Mercury Disposal and Recycling
LCD lamp(s) in this monitor contain mercury. Dispose or recycle according 

to local, state or federal laws. Consult the Electronic Industries Alliance at 

www.eiae.org for more information. For specific information on lamp 

disposal, consult www.lamprecycle.org.

Cleaning
If you need to clean the unit, use a soft, nonmetallic brush. Make sure that 

the unit is completely dry and free from contaminants before returning it to 

service.
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B
Serial Port Settings

COM1/COM3 Connector Pinout

The following figure and table show the COM1/COM3 connector pinout.

Pin Signal

1 NDCD

2 NRX

3 NTX

4 NDTR

5 GND

6 NDSR

7 NRTS

8 NCTS

9 NRI

1 5

96
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COM4 Connector Pinout and Settings

The PPC-2115/TPC-2515 COM4 serial port is adjustable. You can set it to 

RS-232, RS-422, or RS-485, and it has auto data flow control capability. In 

other words, the PPC-2115/TPC-2515 can automatically detect the data 

flow direction at this port when two-wired RS-485 communication is 

activated.

The following figure and table show the COM4 pinout and settings.

COM4 Mode S1 and S2 Setting

RS232 Mode

RS485 Mode

RS422 Master Mode

RS422 Slave Mode

1 5

96
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PIN RS-232 RS-422 RS-485

1 NDCD TX– D–

2 NRX TX+ D+

3 NTX RX+ —

4 NDTR RX– —

5 GND GND GND

6 NDSR — —

7 NRTS — —

8 NCTS — —

9 NRI — —
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C
Watchdog Timer Programming

Overview

You can use the PPC-2115/TPC-2515 watchdog timer to monitor system 

software operation and take corrective action if the software fails to 

function after the programmed period. This appendix describes how to 

program the watchdog timer operation.

The watchdog timer is built into the W83627HF I/O controller. It includes 

the following programmable functions:

• You can enable and disable the timer via programming.

• You can set the timer interval from 1 to 255 seconds or 

1 to 255 minutes.

• The timer generates an interrupt or resets the signal if the software fails 

to reset the timer after a timeout.

Watchdog Timer Programming

The watchdog timer I/O port address is 2E (hex) (the address port) and 

2F (hex) (the data port). You must first assign the register address by 

writing the address value to address port 2E (hex), then write/read data 

to/from the assigned register through data port 2F (hex).
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Figure C-1 describes the watchdog timer programming procedure, and 

Table C-1 describes the watchdog timer registers.

Figure C-1.  Watchdog Timer Programming Procedure

Unlock W83627

Select Watchdog Timer Register

Enable Watchdog Timer Function

Use Watchdog Timer Function

Lock W83627HF
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Table C-1.  Watchdog Timer Registers

Address of Register (2E) Attribute Description

Read/Write Value (2F) and description —

87 (hex) — Write this address twice to I/O 

address port 2E (hex) to unlock the 

W83627HF.

07 (hex) Write Write 08 (hex) to select the watchdog 

timer register.

30 (hex) Write Write 01 (hex) to enable the 

watchdog timer function. The default 

is disabled.

F5 (hex) Write Set seconds or minutes as the timer 

unit.

Write 0 to bit 3 (default): second.

Write 1 to bit 3: minute.

F6 (hex) Write 0: Stop timer

01 to FF (hex) (default): The count 

amount, in seconds or minutes, 

depends on the value set in register 

F5 (hex). This number determines 

how long the watchdog timer waits 

for the strobe before generating an 

interrupt or reset signal. Writing a 

new value to this register resets the 

timer to count with the new value.

F7 (hex) Read/Write Bit 6: Write 1 to enable the keyboard 

to reset the timer. Write 0 to disable.

Bit 5 (default): Write 1 to generate a 

timeout signal immediately and 

automatically return to 0.

Bit 4 (default = 0): Read the 

watchdog timer status. 1 means the 

timer is timeout.

AA (hex) — Write this address to I/O port 2E 

(hex) to lock the watchdog timer.
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Example Programs

Example 1: Enable the Watchdog Timer and Set 10 s as the 
Timeout Interval
;-----------------------------------------------------------

Mov dx,2eh ; Unlock W83627HF

Mov al,87h

Out dx,al

Out dx,al

;-----------------------------------------------------------

Mov al,07h ; Select registers of watchdog timer

Out dx,al

Inc dx

Mov al,08h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Enable the function of watchdog timer

Mov al,30h

Out dx,al

Inc dx

Mov al,01h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Set second as counting unit

Mov al,0f5h

Out dx,al

Inc dx

In al,dx

And al,not 08h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Set timeout interval as 10 seconds and start counting

Mov al,0f6h

Out dx,al

Inc dx

Mov al,10

Out dx,al

;-----------------------------------------------------------

Dec dx ; lock W83627HF

Mov al,0aah

Out dx,al
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Example 2: Enable the Watchdog Timer and Set 5 Min as the 
Timeout Interval
;-----------------------------------------------------------

Mov dx,2eh ; unlock W83627H

Mov al,87h

Out dx,al

Out dx,al

;-----------------------------------------------------------

Mov al,07h ; Select registers of watchdog timer

Out dx,al

Inc dx

Mov al,08h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Enable the function of watchdog timer

Mov al,30h

Out dx,al

Inc dx

Mov al,01h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Set minute as counting unit

Mov al,0f5h

Out dx,al

Inc dx

In al,dx

Or al,08h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Set timeout interval as 5 minutes and start counting

Mov al,0f6h

Out dx,al

Inc dx

Mov al,5

Out dx,al

;-----------------------------------------------------------

Dec dx ; lock W83627HF

Mov al,0aah

Out dx,al
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Example 3: Enable the Mouse to Reset the Watchdog Timer
;-----------------------------------------------------------

Mov dx,2eh ; unlock W83627H

Mov al,87h

Out dx,al

Out dx,al

;-----------------------------------------------------------

Mov al,07h ; Select registers of watchdog timer

Out dx,al

Inc dx

Mov al,08h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Enable the function of watchdog timer

Mov al,30h

Out dx,al

Inc dx

Mov al,01h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Enable watchdog timer to be reset by mouse

Mov al,0f7h

Out dx,al

Inc dx

In al,dx

Or al,80h

Out dx,al

;-----------------------------------------------------------

Dec dx ; lock W83627HF

Mov al,0aah

Out dx,al
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Example 4: Enable the Keyboard to Reset the Watchdog Timer
;-----------------------------------------------------------

Mov dx,2eh ; unlock W83627H

Mov al,87h

Out dx,al

Out dx,al

;-----------------------------------------------------------

Mov al,07h ; Select registers of watchdog timer

Out dx,al

Inc dx

Mov al,08h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Enable the function of watchdog timer

Mov al,30h

Out dx,al

Inc dx

Mov al,01h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Enable watchdog timer to be strobed reset by keyboard

Mov al,0f7h

Out dx,al

Inc dx

In al,dx

Or al,40h

Out dx,al

;-----------------------------------------------------------

Dec dx ; lock W83627HF

Mov al,0aah

Out dx,al
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Example 5: Generate a Timeout Signal without Timer Counting
;-----------------------------------------------------------

Mov dx,2eh ; unlock W83627H

Mov al,87h

Out dx,al

Out dx,al

;-----------------------------------------------------------

Mov al,07h ; Select registers of watchdog timer

Out dx,al

Inc dx

Mov al,08h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Enable the function of watchdog timer

Mov al,30h

Out dx,al

Inc dx

Mov al,01h

Out dx,al

;-----------------------------------------------------------

Dec dx ; Generate a time-out signal

Mov al,0f7h

Out dx,al ;Write 1 to bit 5 of F7 register

Inc dx

In al,dx

Or al,20h

Out dx,al

;-----------------------------------------------------------

Dec dx ; lock W83627HF

Mov al,0aah

Out dx,al
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D
Accessory Kit Assembly 
Procedure

This appendix explains how to connect to a CD-ROM via the 

CompactFlash slot.

CompactFlash to IDE Transfer Kit Assembly

Follow these steps to connect to a CD-ROM via the CompactFlash slot:

1. Connect the IDE cable to the adapter board.

2. Insert the adapter board into the CompactFlash slot.

3. Connect the CD-ROM to the IDE cable.

4. Connect the external power line to the CD-ROM.
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E
Touchscreen Configuration

This appendix explains how to configure the PPC-2115/TPC-2515 

touchscreen using the PenMount Control Panel.

Touchscreen Calibration

Click the pm icon in the lower right corner of the screen to access the 

PenMount Control Panel. The panel contains five functions: Calibrate, 

Draw, and Option, all described below, Multiple Monitors, and About. 

Multiple Monitors is for calibrating multiple touchscreen displays only; 

it does not apply to the PPC-2115/TPC-2515, which allows only one 

touchscreen display. About shows the driver version.

Calibrate
There are two ways to calibrate the touchscreen—standard calibration and 

advanced calibration.

Use standard calibration to adjust newer touchscreens, which need only a 

few calibration points. Follow these steps to use standard calibration:

1. Click the Standard Calibration button on the Calibrate tab of the 

PenMount Control Panel.

2. A screen with a small red square appears. Touch the red square on this 

screen and the screens that follow it.

3. The calibration is complete after you touch the red square on the 

fifth screen.

Note Press <ESC> to skip any calibration screen.
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Use advanced calibration for older touchscreens, which may need 

additional calibration. Advanced calibration uses 4, 9, 16, or 25 calibration 

points. Follow these steps to use advanced calibration:

1. On the Calibrate tab of the PenMount Control Panel, set the number 

of calibration points in the Advanced Mode drop-down menu.

2. Select Plot calibration data if desired. If you enable Plot calibration 

data, blue lines show linearity before calibration, and black lines show 

linearity after calibration.

3. Click the Advanced Calibration button.

4. A screen with a small red square appears. Touch the red square on this 

screen and the screens that follow it.

5. The calibration is complete after you touch the red square on the last 

screen.

Draw
The draw option tests touchscreen operation by showing touch location. 

Follow these steps to use the draw function:

1. Click the Draw button in the Draw tab of the PenMount Control Panel.

2. Touch several points on the screen. The screen should show the points 

you touched.

3. Click Menu»Clear Screen to clear the drawing.

Option
Use the controls in the Option tab to set the operation mode and beep 

sound. In Stream Mode, the mouse functions normally. In Point Mode, 

the mouse has only a click function; onscreen dragging is disabled. Select 

Enable Beep Sound to turn on the beep sound. Adjust the beep frequency 

and duration using Beep Frequency and Beep Duration. Click Back to 

Default to restore the defaults.
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F
Fuse Replacement

Caution Do not replace the fuse unless it is damaged. Do not replace the fuse with a 

differently rated fuse. For more information, see the fuse specifications in Appendix A, 

Specifications.

Follow these steps to replace the fuse:

1. Remove the fuse cover.

2. Replace the damaged fuse with a new one.

3. Place the fuse cover back into position.
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G
Features in Windows XP 
Embedded (TPC-2515)

The TPC-2515 supports the Windows XP Embedded platform (commonly 

abbreviated XPe), which is a componentized version of the Windows XP 

Professional edition. This appendix explains the version information and 

the EWF utility for Windows XP Embedded.

Version Information

You can access the version information by selecting Start»All Programs»

Utilities.

The version information states the current XPe runtime information 

including hardware platform, version, build number, release date, XPe 

QFEs installed in the component database, and Windows XP Pro patches 

installed.

EWF

Enhanced Write Filter (EWF) provides an upper filter in the storage device 

driver stack that redirects disk write operations to volatile (RAM) or 

nonvolatile (disk) storage. EWF protects a volume from write access and 

offers the following benefits:

• Write-protects one or more partitions on your system.

• Enables read-only media, such as CD-ROM or flash, to boot and run.

• Prolongs the life span of write-sensitive storage, such as 

CompactFlash.

To disable/enable EWF, go to Start»All Programs»Utilities and select the 

EWF tab. The default setting is disabled.

When EWF is enabled, the C: partition is protected from any disk writing. 

In this mode, any changes on the C: partition (including modifications to 

files or the registry) are redirected to memory. Thus, these changes are 

discarded in the next system startup. You can manually enable this mode 

after finishing all system changes such as installing your applications or 

adjusting system settings.
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Login

By default, XPe automatically logs into the Administrator account. The 

default password is password, all lower case, with no quotes.

The Administrator account defaults are:

• Login: Administrator

• Password: password
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H
Technical Support and 
Professional Services

Visit the following sections of the award-winning National Instruments 

Web site at ni.com for technical support and professional services:

• Support—Technical support at ni.com/support includes the 

following resources:

– Self-Help Technical Resources—For answers and solutions, 

visit ni.com/support for software drivers and updates, 

a searchable KnowledgeBase, product manuals, step-by-step 

troubleshooting wizards, thousands of example programs, 

tutorials, application notes, instrument drivers, and so on. 

Registered users also receive access to the NI Discussion Forums 

at ni.com/forums. NI Applications Engineers make sure every 

question submitted online receives an answer.

– Standard Service Program Membership—This program 

entitles members to direct access to NI Applications Engineers 

via phone and email for one-to-one technical support as well as 

exclusive access to on demand training modules via the Services 

Resource Center. NI offers complementary membership for a full 

year after purchase, after which you may renew to continue your 

benefits. 

For information about other technical support options in your 

area, visit ni.com/services, or contact your local office at 

ni.com/contact. 

• Training and Certification—Visit ni.com/training for 

self-paced training, eLearning virtual classrooms, interactive CDs, 

and Certification program information. You also can register for 

instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 

technical resources, or other project challenges, National Instruments 

Alliance Partner members can help. To learn more, call your local 

NI office or visit ni.com/alliance.
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If you searched ni.com and could not find the answers you need, contact 

your local office or NI corporate headquarters. Phone numbers for our 

worldwide offices are listed at the front of this manual. You also can visit 

the Worldwide Offices section of ni.com/niglobal to access the branch 

office Web sites, which provide up-to-date contact information, support 

phone numbers, email addresses, and current events.
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